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What will we learn today?

1. Data Analytics

2. Data Visualization
3. Data Wrangling
4,

Power Query



1. Data Analytics



What is Analytics?

Analytics is an encompassing, multidimensional field that uses mathematics, statistics, predictive modelling and machine
learning techniques to find meaningful information from data. It is the discovery, interpretation and communication of
meaningful patterns and trends in data and applying them towards effective and data-driven decision making.

Types of Analytics:
* Descriptive: Analytics that helps you understand how things are going. |III| DeSCI"IptIVG

Think: what has happened? Examplec are: cash flow and revenue analysis.
Predictive oa'

* Prescriptive: Analytics that suggest a prescribed next step or action. @

* Predictive: Analytics that help you forecast future performance and results.
Think: what could happen? Example ic: sentiment analysis.

Prescriptive

Think: what should we do? Example ic: Google’s self-driving car.

Data Analytics is the science of examining raw data in order to draw conclusions about the information it provides.



Data Analytics

Impact on Business

* enables new products and services which can lead to the creation and emergence of new markets. An example
of new products includes wearables such as Fitbits or smart jewelry.

* disrupts existing markets and unseats traditionally secured businesses through innovation. Uber is a good
example where data analytics has been a major factor in the growth of the company and disruption of the taxi
industry.

» drives increased efficiency. For example, with the help of data analytics, retailers are able to optimize supply
chain through custom-tailored offerings based on trends and forecasts that are backed up with data.



CSF for Data Analytics
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Purpose

Understanding the goal and the
guestions that need to be answered
is the first step for a successful
analysis. Work done with the data
should link directly with the issue
on hand and should aim to add
value to the users.

Know-how

Having the correct level of skills,
techniques and judgement is
important to be able to collect
valuable data efficiently, analyze it
to quickly generate outputs and

accept, reject or refine hypotheses.

Compelling insight

Skilled analysis develops ideas and
reveals insights that may not be
obvious. However, it is key to
present insights as a visually
compelling story that makes
complex issues easy to understand.



2. Data Visualization



Data Visualization

Data visualization is the graphical representation of information and data.

It is using visual elements such as graphs, charts, dashboards and maps as well as tools to provide accessible ways to see
and understand trends, outliers and patterns. Data visualization is particularly important in the world of Big Data due to
the need to analyze massive amounts of information in order to make key decisions.

Quality traits of good data visualization:

Truthful: avoids deception and dishonesty with audience and maintains clarity when presenting information.

Functional: built in a way that allows people interpret it correctly and do meaningful operations; it shows
connections between data and tells an easy to follow story to allow the audience to quickly understand and use the
information presented.

Beautiful: has an appealing structure, formatting and visual form.

Insightful: reveals evidence that audience would have a hard time seeing otherwise and clears the path to make
valuable discoveries that would be inaccessible if information were presented in a different way.

Enlightening: changing people’s mind for the better and revealing information that increases their well-being.



Examples of Misleading Visualization

a. Omitting the baseline

Typically, graphs start with a baseline of 0.
However, designers can skew how the data is
perceived by changing the baseline to a different
number. This is known as a “truncated graph”.

The graph on the left is misleading because the
Y-axis starts with a value of 50, making any small
difference between the groups seem massive.
Group A appears to have a much larger average
grade than Groups B and C.

On the other hand, the graph on the right starts
with a value of 0 on the Y-axis, offering a more
accurate depiction of the data and a less
dramatic difference between the groups.
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Examples of Misleading Visualization

b. Manipulating the Y-axis

Expanding or compressing the scale on graphs
may result in making data seem more or less
significant than it actually is.

The graph on the left is misleading because the
scale is disproportionate to the data, making the
change in the number of exceptions over time
seem small.

On the other hand, the graph on the right has a
more proportionate scale to the data, and
therefore shows a greater change in the number
of exceptions over time.
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Examples of Misleading Visualization

c. Cherry-picking the data

Only certain data points may be included on
graphs by designers to reinforce a certain
narrative or hidden agenda, leading to a false
impression of the data to be perceived.

The graph on the left is misleading because it
includes only a few months from the year,
depicting an upward percentage increase in
revenue.

On the other hand, the graph on the right is
more accurate since it includes a wider range of
data, revealing the true overall trend of revenue
over the years and showcasing the bigger
picture.
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Examples of Misleading Visualization

d. Omitting the data

Omitting certain data points allow designers to
create trends that don’t really exist. This is due
to the fact that by omitting data, designers do
not present the full context. Simply put, why lie
when you can just omit?

The graph on the left shows the total revenue on
a bi-annual basis, leaving out some data points,
and making the graph look much smoother and
stable. Users may perceive a steady increase of
revenue over the years with little context.

The graph on the right is more accurate since it
plots total revenue for every year, depicting a
more accurate representation of a more volatile
increase in revenue over the years.
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3. Data Wrangling



Data Wrangling

Data wrangling is the process of cleaning, restructuring and enriching available raw data into a format that is more
usable. This allows users to ease and quicken their decision-making process and get better data insights.

O

What it looks like What it feels like What you need

Practitioners consistently report that around 80% of the effort involved in dealing with data is cleaning it up, massaging
it and getting it ready for use.

14



The Data Wrangling Steps

Discovering

Structuring
Cleaning
Enriching
Validating

Publishing

Allows data analyst to understand the data and how useful it is for analytic
exploration and analysis.

This is where a deeper understanding of the data is obtained.

15



The Data Wrangling Steps

Discovering

Structuring

Cleaning

Enriching

Validating

Publishing

Gives the ability to format data of all shapes and sizes to work with traditional

applications. In most cases, raw data is obtained in a haphazard manner with no
structure. It may come in a form that may look great to human eyes, but is a
disaster for analytical softwares such as Excel and Alteryx. Structuring data may
include splitting columns, pivoting rows and deleting fields, among other things.

Below is an example of transforming a typical excel income statement schedule
to a “flat file” format to be imported into an analytical tool.

A B C

1 |Income Statements - 2017 to 2019

v e wN

7
8
9
10
1
12
13
14
15
16
17
18

D

E

F

G

H

I

$ in thousands 30-Oct-18  30-Nov-18 31-Dec-18  31-Jan-19 28-Feb-19 31-Mar-19
Accomodation Sales 56,451 59,232 62,343 63,234 63,432 62,789
Food Sales 234 532 345 289 456 398
Merchandise Sales 145 230 179 178 254 200
Total Sales 568307 59994  62,867° 63,7017  64,142" 63387
Cost of Sales 17,242 19,342 18,034 18,234 18,906 19,234
Gross Profit 39,588 40,652 44,833 45,467 45,236 44,153
Direct Costs 14,564 14,742 13,980 14,789 14,435 13,753
HO Overheads 234 532 589 502 498 569
EBITDAR 24,790 25378 30,264 30,176 30,303 29,831
Rent 13,455 13,455 13,455 13,455 13,455 13,455
EBITDA 11,335 11,923 16,809 16,721 16,848 16,376
Hotel (1) Hotel (2) Hotel (3  +

»

NV D WNR

i3
14
15
16
17

A
Hotel
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)

|Hotel (1)

Hotel (1)
Hotel (1)
Hotel (1)
Hotel (1)

B

Line Item

Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales
Accomodation Sales

(&

Date

30/09/2019
25/07/2019
21/03/2019
05/03/2019
06/03/2019
25/07/2019
20/09/2018
13/11/2018
12/05/2019
13/08/2018
02/02/2018
05/03/2019
06/03/2019
09/12/2017
06/06/2018
19/07/2018

D
Value

10942.32
13242.21
1238
56321.21
2314.1
12312.12
34341
4312.34
312312.43
43578.3
3432657.87
434.3
3454.65
3431.1
76534.21
3331.1
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The Data Wrangling Steps

Discovering

Structuring

Enriching

Validating

Publishing

Involves identifying data quality issues and removing any outliers in the dataset
which can skew and distort the results of the analysis. In addition, any null values
will have to be changed, and the formatting will have to be standardized in order

to improve data quality.

A data set is said to be clean if:

1. Each piece of the data is in
a format that a software can
‘read’

Common formatting errors:

e A zero is reported as “NULL”
or a blank cell

e A number is entered as a
text object

e A piece of data has an extra
character

¢ A “leading space” —a blank
space before the piece of
data

2. There is 100% consistency

in the format of the data
items in each record

Common inconsistencies:

¢ The Date field has dates in
different formats

¢ The data is in different units
(for example, a mix of
centimeters and inches)

3. It is complete and

accurate

Common incompleteness &

inaccuracy issues:

¢ One-off errors — for
example, missing dataina
cell or missing block of rows

¢ A pattern — for example,
every third row is missing

17



The Data Wrangling Steps

Discovering
Structuring
Cleaning
Validating

Publishing

Once data has been cleaned, it will have to be enriched.

This entails taking stock of what is in the data and strategizing to determine
whether it must be augmented using some additional data in order to make it
better. The existing dataset may be enriched by joining and aggregating multiple
data sources.

18



The Data Wrangling Steps

Discovering

Structuring

Cleaning

Enriching

Validating

Publishing

It is essential to manually check datasets and perform a final human check for
any missing or mismatched data that wasn’t corrected during the transformation
process.

Validating that the output dataset has the intended structure, consistency and
content before publishing is a key step in the data wrangling process.

19



The Data Wrangling Steps

Discovering

Structuring

Cleaning

Enriching

Validating

Publishing

I

Once the data has been successfully structured, cleaned, enriched and validated,
it is time to publish the wrangled output for downstream analysis.

The data wrangling process allows users to see a wide range of statistics and
analytics that aim to add value to the organization and make better decisions.

20



Meet the Data Analyst
aka Data Wrangler

Data wrangling is the process of transforming raw data into information that is usable for informed decision making.

Raw Data Data Analyst Information Output

(Structured & |:> wrangling with :> after
Unstructured) Raw Data A LOT of work



4. Power Query



Power Query
to the rescue

Power Query is a strong ETL tool and the modern Accountant’s best friend.

Extract Transform
Data from any source Data in a logical sequence

Connect to Implement your Load the result

virtually any own logic into
Data Source and get exactly a table in Excel
and extract the data the table you need or Power B

23



What is Power Query?

Power Query is a business intelligence tool available in Excel that allows you to import data from
many different sources and then clean, transform and reshape your data as needed.

It allows you to set up a query once and then reuse it with a simple refresh. It is pretty powerful.
Power Query can import and clean millions of rows of data for later analysis and presentation.

The user interface is intuitive and well laid out so it’s really easy to learn. It has an incredibly short
learning curve when compared to other Excel tools like some of the more complex formulas in Excel
or VBA.

The best part about it, is you don’t need to learn or use any code to do any of it. The power query
editor records all your data transformations step by step and converts them into its code language,
called 'M'. This is very similar to how the Macro recorder works in Excel to generate VBA code.

If you want to edit or write your own M code, you certainly can, but you don’t need to worry about
this as a beginner and certainly not for your exam.

24



What can Power Query do?

Sales ID,Product ID,Date,Comm Rate,Sales | Imagine you get a sales report uploaded in a CSV file format on a
leeel,l1e03eeel,2016-08-28,25.0%,65.5

10002, 10030002 2017-11-01.25.0%.59.5 monthly basis that looks like the screenshot to the left. Based on
16003,10030001,2016-01-29,25.0%,65.5 data in this file, you are asked to calculate commission due to each
1eee4,1001e0e1,2016-83-12,10.0%,1499.5 3 : i %
10005 10030003, 2016-03-04. 25. 0%, 16. 5 salesperson and present it as below. If doing this in Excel ...
16066,106030004,2017-09-30,25.0%,56.5
10007, 10030005, 2016-12-29,25.0%,9.6 ... each month you’d have to go to the FEIETZEETNN - FEEIETTETT -
16068,100300081,2017-82-01,25.0%,65.5 . . Ryan Bohan $1,694.23
10005, 10030005 2016-09-06. 25.0%.9. 6 folder where the file is uploaded, open e e
16004 ,10030006,2016-05-20,25.0%,12.9 the file and copy its contents into Excel. colin abthorpe $411.15
VAU L8600l BA LGNl g P _ . Doug Howis $2,779.53
You would then use the text-to-column feature in Excel to split out the data  maxrenton $2,999.73
into new columns. The sales report only shows [Sales ID], so you would SienThumie S1.339.53
. Reilly Wynne $668.75
need to add a new column to the Excel file and use a VLOOKUP to get the TE—— $644.18
salesperson associated with each [Sales ID]. You would then summarize the Raguel Lilywhite $2,315.28
.. Johanna Marten $1,101.20
total sales by each salesperson and calculate the commission to pay out. CTYGL s o o 485,65

Maybe it only takes an hour or so each month, but it’s pretty mindless work that’s boring, unenjoyable

and takes away from time you can actually spend analyzing the data and producing meaningful insight.
25



What can Power Query do?

With Power Query, all of the
steps mentioned on the previous
page can be automated down to
a click of the Refresh button on a
monthly basis.

O te!

Define Consume
once anytime

All you need to do is build the
query once and reuse it each
month, thereby saving an hour of
time each and every month.

Sales ID,Product ID,Date,Comm Rate,Sales
16001,10030001,2016-08-28,25.
10002,10030002,2017-11-01,25.

16063,10030001,2016-01-29,25

16006,10030004,2017-09-30,25

16605,10030005,20816-09-86,25

0%,65.5
0%,59.5

.0%,65.5
10004,10010001,2016-03-12,10.
10005,10030003,2016-03-04,25.

0%,1499.5
0%,16.5

.0%,56.5
10007,10030005,2016-12-29, 25.
10008,10030001,2017-62-01, 25.

0%,9.6
0%,65.5

.0%,9.6
10004,10030006,2016-05-20,25.

0%,12.9

sales Person @ Total Commission B3

Ryan Bohan
Arron Mattin
Collin Abthorpe
Doug Howis

WAL g A2 A0S IQLT  Ollmedie-3) el 1 3.8 - Max Renton

Go from raw data
to cleaned and

summarised with

one click

Glen Thomke
Reilly Wynne
Harvey Caven
Raquel Lilywhite
Johanna Marten

$1,694.23
$1,139.43

$411.15
$2,779.53
S
$1,939.93

$668.75

$644.18
$2,315.28
$1,101.20

leeacTlagd . o o ot o0 7" 5483.65)

26



Power Query
what makes it stand out?

Simple
Intuitive and easy to use

Practical
Created for the business user having no coding skills

Compatible
Same code works everywhere

Rich
New features and data connectors are constantly being added

Familiar
Easy to grasp features and learn the programming language (called M)

{é} Scalable
Same solution can work on the desktop, on the web or on mobile media

QO te!

Define Consume
once anytime

27



Power Query
where can you find it?

Power Query was initially B E o -8-0- - Book2 - &
released after Excel 2013 as a m HOME  INSERT  PAGE LAYOUT FORMULAS DATA  REVIEW  VIEW POWE"
free add-in for Excel, and it was - i B ¢ > N === = R ol s W ==+ S
(rather shockingly) backward fow T B Mo ikt sk | T :ﬂ.:qe Append Show Launch Data A Options
compatible with Excel 2010. In Web File = Database = Azure = Sources = Sources~ Table Pane Editor Settings "7

ot Eernal Data £xcel Data Combine workbook Quenie Settngs

both of those versions, a unique
ribbon tab holds all the Power

Book3 - Eg

File Home Insert Page Layout Formulas Review View Developet Power Pivot

Query commands. Because Power afrom Access [ B show Quens EComections o 7T W T
Query IS S0 Incredlbly UserI, it - .\‘:hom o From Other Existing New .v & d skomons Refresh ' % Sort Filter '
only made sense to integrate the fromText  sources~  Connection®y Query ~ L& Recent Sources Jf agy- e Edit Lind . Vb

Get External Data . Connections Sot & Flter ¢

tool into Excel 2016. Due to
concerns about bloating the user
interface, though, Power Query

B EH 5 ¢ &- = | Untitled - Power Bl Desktop

-

was not given its own ribbon tab b ) wid) ‘
. % Get Recent Eon M P ’
in Excel 2016 but was instead Data > Sources ~ Queries x - )

[ PowerBI | Excel 2016

squished down into the Get &
Transform group on the Data tab. The image above shows where Power Query is accessible in both Excel & Power BI.
28



Importing Data with Power Query

Importing your data with Power Query is simple.

s, H Ll SRR -man G & |

Excel provides several different data connections that are X ~sm

- File Home Insert Draw Page LayG hsﬁnmuks Review
accessible from the Data tab and can t?e found under the. TR
Get Data command. Note that the available data connection | - 20 [l B4

Get From From From Table/ Recent
Data~ Fext/CSV Web Range Sources Connections  All~

options for Get Data is dependent on your version of Excel. L Svenes & Conmections

In general, you can ...
... Get data from a single file such as an Excel workbook, Text or CSV file, XML and JSON files. You can also
import multiple files from within a single folder.

... Get data from various databases such as SQL Server, Microsoft Access, Analysis Services, SQL Server
Analysis Server, Oracle, IBM DB2, MySQL, PostgreSQL, Sybase, Teradata and SAP HANA databases.

... Get data from Microsoft Azure and from other online services like Sharepoint, Microsoft Exchange,
Dynamics 365, Facebook and Salesforce.

... Get data from other sources like a table or range inside the current workbook, from the web, a Microsoft
Query, Hadoop, OData feed, ODBC and OLEDB. 29



Importing Data with Power Query

There are some of the more common data connection options available within = N
e B |

top level of the Ribbon, as found in Get & Transform Data section of the Datatab. .. r.. fo fromtobier Recon
Data - | Text/CSV  Web Range Sources

From here, we can easily access From Text/CSV, From Web & From Table/Range Get & Transform Data
queries. These are duplicated outside of the Get Data command simply for the sake of convenience.
= <] Depending on which type of data connection you
51 e . | choose, Power Query will guide you through the data
= FE e T e B connection setup; and there might be several options
i o s i " | to select during the process.

Eraser

At the end of the setup process, you will come to the
Data Preview window. You can preview a sample of the
s data here to confirm it is what you’re expecting. You can
then load the data as-is by pressing the Load button, or
you can proceed to the query editor to apply any data
transformation steps by pressing the Edit button.




Importing Data in an Excel File

Let’s take a look at importing some data from an Excel workbook in action.

=l IR

Get From

From From Table/ Recent

e

Existing
Sources (Connections

From Workbook

Data ~ |Text/CSV Web Range
Get & Transform Data
j From File »
o
From Database 4

am From Azure 4
=

L From Online Services "

D }
’_},_ From Other Sources
. . mbnde  _aee ,

——

:E From Text/CSV
B

_ From XML
ij@ From JSON

From Folder

o
@ From SharePoint Folder

We shall import an Excel file called Office Supply Sales
Data.xlIsx. It contains sales data on one sheet called Sales
Data and customer data on another sheet called Customer
Data. Both sheets of data start in cell A1 and the first row
of the data contains column headers.

Go to the Data tab and select the Get Data command in the
Get & Transform Data section of the =~ - ;
Ribbon. Then go to From File and = == -
choose From Workbook. i

This will open a Import Data dialog
form where you can navigate to the
file you want to import. Select the
file and click on the Import button.

.

B Desktop

& Downloads
b Vs

B Videos

ECUSCGR21SYBR ()
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Importing Data in an Excel File

After selecting the file you want to import, the data
preview Navigator window will open. This will give
you a list of all the objects (data tables and ranges)
available to import from the workbook.

Check the box to Select multiple items since we will be
» importing data from two different worksheets. Now we
can check both the Customer Data and the Sales Data.

When you click on either of the objects in the workbook,
you can see a preview of the data for it on the right hand

side of the Navigator window. This is a great way to perform a reasonability check to validate
whether or not you’ve got the correct file.

When you're satisfied that you’ve got everything you need from the workbook, you can press either one of
the Edit or Load buttons. The Edit button will take you to the Query Editor where you can transform your

data before loading it. Pressing the Load button will load the data into tables in new sheets in the workbook.

32



Importing Data in an Excel File

For now, let’s bypass the Query Editor and go straight to loading the data into Excel.

Import Data ? X | Press the small arrow next to the Load button to access the Load To... options.
Se'eé"géggéa“m"iew"‘“ data inyeurworkbook: | This will present you with a Import Data form with a few more loading options.
[#] O wotTable Report We will choose to load the data into a Table in a New worksheet. However,
'E ?);Nwtgchﬂt Connection note there are several other options to choose from.

s s v x
Where do you want to put the data? QU@I Ies & Connecuons

s bl As seen in the screenshot to the left, you may also Sece({Comos

52

® New worksheet load the data directly into a PivotTable Report, ora ¢
. . . . E Customer Data
LTAmaIE St e ot Min el PivotChart, or you can completely avoid loading the o
<<_| data and just Only Create Connection to the data. [ Sales Data 3

1,145 rows loaded.

As we click on OK, the two tables are loaded into two new worksheets in Excel and

we also have two queries which can quickly be refreshed if the data in the original =« ior /e oo e
workbook is ever updated. Excel shows us the queries in a side panel called Queries & Connections. We can
later select any one of these queries and click on Edit to go back and make changes to the query as required.




The Query Editor

After connecting to your data and selecting the Edit option, you are presented with the Query Editor. This is
where any data transformation steps will be created or edited.

There are 6 panes in the Editor you need to be familiar with:

1. Ribbon — The user interface for the Editor is quite similar
to Excel and uses a visual ribbon style command center. It
organizes data transformation commands and other Power
Query options in the remaining 5 panes.

2. Query List — This pane lists all the queries in the current
workbook. You can navigate to any query from this pane to
begin editing it. You can collapse and expand this pane.

3. Data Preview — This pane is where you see a preview of the data with all the transformation steps
currently applied. You can also access a lot of the transformation commands here either from the filter icons
in the column headings or with a right click on the column heading.

34



The Query Editor

We explored 3 of the 6 panes in Query Editor on the previous page. Below are the remaining 3 ...

4. Formula Bar — This is where you can see and edit
the M code of the current transformation step. Each
transformation you make on your data is recorded and
appears as a step in the Applied Steps pane.

5. Properties — This is where you can name your query.

- B 1 le When you close and load the query to an Excel table,
== = Power Query will create a table with the same name as its
. = source query if the table name isn’t already taken. Giving a

meaningful name to the query is important as this name is
what the M code will refer to if we were to query it in another query.

6. Applied Steps — This pane shows a sequential list of all the transformation steps that have been applied
to the data. You can move through the steps here and view the changes in the Data Preview pane. You can
also delete, modify or reorder any steps in the query here.

35



The Query List

The Query List has abilities other than just listing out all queries in the current workbook. y

One of the primary functions of the Query List is Navigation. There’s no need to exit the [ Sales_Data
Query Editor to switch which query you’re working on. You can click on any query inthe = “=°m=g

Query List to switch to it. The query you’re currently on is highlighted in light green color. .. - . ,, ,
When you exit the Query Editor, all changes made in all the queries you edited will automatically be saved.

<| Youcan hide the Query List to create more room for the Data Preview.

g EE'ES-D“BD To do so, simply click on the small arrow in the upper right corner of the Query List to
ustomer_Data

toggle the list between hidden (collapsed) and visible (expanded).

—— e b
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The Query List

If you right click on any query in the Query List pane, there are a variety of options available...

Queries 2] <
7] Sales_Data
FH Customer_Data By

. o atbebd

The optione ;\11
ex/:/orea/ on Em
thic page U
are

relevant for

the exam.

i~ 1

Copy

Paste

Delete

Rename
Duplicate
Reference

Move To Group
Move Up

Move Down
Create Function...
Convert To Parameter
Advanced Editor

Properties...

Copy and Paste — Copy and paste a query to make another copy of it.

Delete — Delete the query. Note that if you accidentally delete a query,
there’s no undo button for it. However, you can exit the Query Editor
without saving to restore your query.

Rename — Rename your query. This is the same as renaming it within the
Properties area of the Query Editor.

Duplicate — Make another copy of the query. This is the same as copy and
paste but completes the process in one step.

Move To Group — Place your queries into a folder like structure to keep them
organized when the Query List gets large.

Move Up and Move Down — Rearrange the order your queries appear in the Query List or within the folder
groups. This can also be done by dragging and dropping the query to its new location.
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The Query List

If you right click on any query in the Query List pane, there are a variety of options available...

<

[ Sales Data

B CustomerData| By Cop

—— J
X Delete

Tle S Rename

By Duplicate
a/blf/omf
Move To Group
explore o
plored
on L%/S’
Ibage ! Advanced Editor

are not

relevant for the exam.

Create Function... — Turn your query into a query function. This allows you to pass a
parameter to the query and return results based on the parameter passed.

Convert To Parameter — Allows you to convert queries to parameters.
Advanced Editor — Open the advanced editor to edit the M code for the query.

Properties... — Allows you to change the query name, add a description text and enable
Fast Data Load option for the query.

| ‘ You can right click any empty area in the Query List to create a new query.

2 Customer_Data [ File

ﬁ [k,“ Paste [% Database
New Query » Ei Azure

v Qu

The menu options that are made available to you after
clicking on New Query are similar to what you would

vy v v v v

A” / A N Online Services . . :
TA | g [T i get if you were to click on the Get Data command in
/ orteu Bl . | the Get & Transform Data section of the Ribbon.
or Collapse Al

[& Recent Sources »

creating new query.
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The Data Preview

The main job of the Data Preview pane is to apply transformation steps to your data and show a preview of
each step you’re applying.

. AB. customer ID ~ || aB. State ~ | AR Product ~ |[2] Order Date - " x

. o - bapercips L% 0.0 IN the data preview area, you can select columns using a few
g 651 Virginia Pencl ws0222 - different methods. Each column will be highlighted in a light
3 |7687 Arizona tepgd 2016-04-22 ..

4 | 1904 Nevada m}i- 705511 green color when it is selected.

5 | 6500 Alabama aser 2017-03-01

5 7687 Arizona Paperciips wi7002:| Select a single column with a left click on the column heading.
7 |3198 North Carolina Notebook 2016-03-07

By %615 Za“f‘“z“" Bet 2705171 Select multiple adjacent columns with a left click on the first
9 |3423 outh Carolina Pen 2016-02-13 . . .

10 %616 Caiifornia Chair .r00:, COluMN heading, then hold Shift and left click on the last

11 |%616 California Pen 2016-09-18 Column heading

12 15800, po bt s Al ot s PERA B e 20560205 z

Select multiple non-adjacent columns by holding Ctrl + left click on any column headings you want to select.

You can then apply any relevant data transformation steps on selected columns from the Ribbon. Certain
commands can also be accessed with a right click on the column heading. Commands that are not applicable

to your selected column or columns will appear grayed out in the Ribbon.
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The Data Preview

Asc _ustomer ID

340

12
36 $
76
15 123
%
6500

7687 E;‘Z'
3188 E
9616 O
Thie i¢ -
B
very A C
relevant x <
for the g

exam.

=
Decimal Number
Currency
Whole Number

Percentage

Date/Time

Date

Time
Date/Time/Timezone

Duration
Text
True/False
Binary

Using Locale...

Each column in the Data Preview pane has a data type icon to the left
of the column heading. You can left click on this icon to change the
data type of the column.

You can choose from any of the data types listed in the screenshot to
the left.

A word on: Using Locale...

Selecting the 'Using Locale...' option allows you to set the data type
format using the specific convention for different locations. You can
use locale for any data type.

For example, if you wanted to display the date in the American locale’s
M/D/YYYY format then you would select 'English (United States)' as
the locale. 40



The Data Preview

There’s DK}@C cusomer D - |

19540 _ - #mE; (-} Renaming any column heading is really easy.
a Sma” T s E® Copy Entire Table : Arizona
table' icon TG B UseFiesi Rowis Headers 5 :. X 2 Double click on any column heading; then type a
inthetop . ., E e e L new name for the column heading and press
A olumn From ‘amp €s... : (s
|eft corner © 7eg7 Invoke Custom Function... : :Irizbona Enter When done.
Of the Data 7 |3198 Add Conditional Column... i North Carolina
§ |96l6 Add Index Column » : Cgimmin m®
PreVieW 2 S Choose Columns :
10 |9616 - e e R PSSP
pane. 19616 *,J& Keep Top Rows... !
, Knnp el . You can change the order of [EISERITU-] Prosuc [Siaie g
YOU.thn click ':fep ZEHT.E of Rows... i columns with a left click Arizona Ly Papercips g Ly 2017-05-29
on it to access eep Duplicates | . Virginia ,  Pendi ) 2016-02-28
various actions Gesp i | and drag-and-drop action. ... vorfl i
N —— BX  Remove Top Rows... i The green border between - Newds Pen 2017-08-31
emove Bottom Rows... I . Alabama Eraser 2017-03-01
at atrec - o B e : tWO COIumns WI” become Arizona Paap:;c!ipf- 2017-06-23
WhOIe table. Remove Alternate Rows... : . S
Reivicide Diplicatis : the new Iocat|on Of the North Carolina Notebook 2016-03-07
R ) | d d col h California Pendil 2017-06-17
\EMmove rrc‘r.- i ragge CO Umn W en you "'\u;hﬁaw B WU SR N s ;‘W*‘U:}?
- . release the left click.
Append Queries... I



The Data Preview

A8 Product

Papercli
Pencil
Notepa:

Pen
Eraser
Paperclips

Notebook

Pgosil s

771/(’ Y
relevant
for the

exam.

g

21 Sort Ascending

El Sort Descending

Remove Empty

Text Filters

4 KSR RS SR

(Select All)

Chair ~

Desk

Eraser

Lamp

Notebook

Notepad

Paperclips

Pen V.

List may be incomplete. Load more
[ o Cancel

Each column has a filter toggle to the right of the column heading,
that looks like a drop-down arrow. Click on it to sort and filter
your data.

The filter options is very similar to the filter options found in a
regular Excel spreadsheet. It also works exactly the same way.

Note:

The list of items shown on initial drop-down is always based on a
sample of the data displayed - so it may not always contain all
available items in the data population.

You can load more data by clicking on the Load more text in blue.
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The Data Preview

A5 Product

Paperclips

Eraser
Paperclips
Notebook

Pencil

The

options |52
explored
here in
clagce are|s
the only
oneg
relevant
for the

exam.

Copy

Remove

Remove Other Columns
Duplicate Column

Add Column From Examples...
Remove Duplicates
Remove Errors

Change Type
Transform

Replace Values...
Replace Errors...

Group By...

Fill

Unpivot Columns

Unpivot Other Columns

Unpivot Only Selected Columns

Rename...

Move

Drill Down

Add as New Query

| Many of the data transformations found in the Ribbon menu are also accessible from the

Data Preview pane, using a right click on the column heading. Following are
some of the available options that we shall explore in class:

Remove — Remove the selected column(s).

Remove Other Columns — Remove all columns other than selected column(s).
Duplicate Column — Copy and paste the column in one step.

Remove Duplicates — Remove rows based on duplicate values in selected column.
Remove Errors — Remove rows based on error values in selected column.

Replace Values... — Find and Replace defined value in column with provided value.
Replace Errors... — Find and Replace error values in column with provided value.

Fill = Fill empty cells in a column, either up or down, with the data in preceding

non-empty cell. 43



The Applied Steps

4 APPLIED STEPS Any transformation you make to your data will appear as a step in the Applied
Ng Steps pane. It also allows you to navigate step-by-step through your query.
g @ Click on any step in the Applied Steps pane, and the Data Preview pane will
update to show all data transformations up to and including that step.

Y e WP St S

You can insert new steps into the query at any point by selecting the previous step and then creating the
transformation in the data preview. Power Query will then ask if you want to insert this new step. Careful
though, as this may break the following steps in the Applied Steps pane that refer to something you changed.

A vieD s You can delete any steps that were applied using the < on the left hand side of
Source the step name in the Applied Steps pane.
Navigation
"Q’[‘i’f;’:zdff::"e" You must exercise caution when deleting a step, since if any of the following
steps depend on the step you’re trying to delete, you will break your query.
Ty e WP e =

This is where Delete Until End from the right click menu can come in handy.
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The Applied Steps

4 APPLIED STEPS
Source
Navigation
< Promoted Headers

Changed Type [}

S Sy R R

A lot of transformation steps available in power query will have various user
input parameters and other setting associated with them. If you apply a filter
on the product column to 'show all items not starting with Pen', you might
later decide you need to change this filter step to 'show all items not equal to
Pen'. You can easily make all such edits from the Applied Steps pane.

Some of the steps will have a small gear icon on the right hand side. This allows you to edit and change the
inputs and settings of that step at any point in time.

4 APPLIED STEPS

Source
Navigation
Promoted Headers

Changed Type n
X Filtered Rows h. ’

steps depend on previous steps, and because of this changing the sequential order of steps can create errors.

You can also rearrange the sequential order in which the steps are performed in
your query.

Just left click on any step and drag it to a new location. A green line will appear
between steps to indicate the new location where it is being dragged to.

This is another example where you must exercise caution, since a lot of following
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The Applied Steps

4 APPLIED STEPS
Source
Navigation
Promoted Headers

X Changed Type %

-,AJFJI'“

TAé’ Opf/OhC
explored on thic
page are relevant

for the exam.

~

g

Right click on any step to access a menu of options.

Edit Settings — This allows you to edit the settings of the step similar to using the

Edit Settings
Rename

Delete

Delete Until End
Insert Step After

Move Up
Move Down

Extract Previous

View Native Query

Properties...

gear icon on the right hand side of the step.

Rename — This allows you to rename the step’s label to something
meaningful, so you can easily identify what the step is doing.

Delete — This deletes the current step.

Delete Until End — This allows you to delete the current step plus all steps up
until the end. Since steps can depend on previous steps, deleting all steps
after a step is a good way to avoid any errors.

Insert Step After — This allows you to insert a new step after the current step in the query.

Move Up and Move Down — This allows you to rearrange the sequential order of steps in the query.

Extract Previous — This allows you to create a new copy of the query up to the selected step. It can be a
really useful option when you want to create a new query based on the logic followed in an existing one. 46



The Formula Bar

When you click on different steps of the 4 APPLIED STEPS
transformation process in the Applied Steps Source See the M code for
Navigation the selected step in
pane, the Formula Bar updates to show the S T— the formula bor
M code that was created for that step. Changed Type
X Filtered Rows t}

If the M code generated is longer than the
formula bar, you can expand the formula bar
using the arrow toggle on the right hand side.

Tr = Table.SelectRows(#"Changed Type”, each ([Product] = "Pen")) v

PO e N |

You can edit the M code for a step directly from the formula bar without the need to
open the advanced editor.

X v k = Table.SelectRows(#"Changed Type", each ([Product] = "[@iEEy")) v |

In our example above , we’ve changed our filter from 'Pen’ to 'Chair' by typing in the formula bar and then
pressing Enter or using the v on the left to confirm the change.

Press Esc or use the < on the left to discard any changes.
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The File tab

é;j Close & Load

AN
’E ; Close & Load To...

’-L';;S Discard & Close

@ -

L
[ . Options and settings »

»

The File tab contains various options for saving any changes made to your queries as well
as Power Query options and settings.

Close & Load — This will save your queries and load your current query into an Excel table
in the workbook.

Close & Load To... — This will open the Import Data menu with various data loading options
to choose from.

Discard & Close — This will discard any changes you made to the queries during your session in the editor
and close the editor.

Note:

* Regardless of saving the query in Power Query, you will still need to save the Excel workbook in the
regular way to keep any changes made to the queries once you close the Excel workbook.

e (Close & Load and Close & Load To... commands are also available from the Home tab.

48



Data Loading Options

When you use the Close & Load To option to exit the editor, this will open the Import Data menu.

Import Data ? X

Select how you want to view this data in your workbook.

] @ Table

O PivotTable Report

15 O PivotChart

[ O only Create Connection
Where do you want to put the data?

(O Existing worksheet:

=SAS1

12>

(® New worksheet

[JiAdd this data to the Data Model:

You can choose to load the query to a Table, PivotTable Report, PivotChart or
Only Create Connection for the query. The connection only option means that
there is no data output to the workbook, but you can still use this query in
other queries. This is a good option if the query is an intermediate step in a
data transformation process.

You are able to select the location to load to in your workbook if you select an
option other than connection only. You can choose a cell in an Existing
worksheet or load it to a New worksheet that Excel will create automatically.

The other option you get is the Add this data to the Data Model. This will allow you to use the data output
in Power Pivot and use other Data Model functionality like building relationships between tables.

The Data Model is Excel’s new and efficient way of storing and using large amounts of data. However, this is
beyond our scope of discussion.
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Queries & Connections

When you’re working outside of the power query editor, you can see and interact F[H [ Queries & Connections

with all the queries in the workbook through the Queries & Connections window.  gesesh IP“’PE”":‘
All ~ : L

To open this, go to the Data tab in the regular Excel ribbon, then press the Queries & Connections
Queries & Connections command button found in the Queries & Connections section.

Chibfies & Connections. ¥ ‘ When opened the Queries & Connections window will be docked to the right hand
Queres | Comectons side of the workbook. You can undock it by left clicking on the title and
P — dragging it. You can drag it to the left hand side and dock it there or

= ki 3 v leave it floating. You can also resize the window by left clicking and

B Custom dragging the edges.

The Queries & Connections window is very similar to the query list in
the editor and you can perform a lot of the same actions with a right
click on any query.

: One point worth noting is that the Load To option is not available in the
By _Properis. right click menu.
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Queries & Connections

Customer_Data “| It is worth noting that when you hover over a query with your mouse, Excel will
; generate a Peek Data Preview, plus show some basic information about the query.

cuenes s comeions T 1 Data Preview — This s a live preview of the data similar to when
first setting up a query.

Columns — This will give you a list of all the columns contained in

N
the final results of the query along with a count of how many
¢ soks 2 columns there are. Clicking on any of them will highlight the
(s | column in the data preview.
S e Last Refreshed — This will tell you when the data was last

Other Q

EDIT DELETE

refreshed.

el O i DA

Load Status — This displays whether the data is loaded to a table, pivot table, pivot chart or is connection only.
Data Sources — This will show you the source of the data along with a total count of files.

View in Worksheet — This will take you to the worksheet if query is loaded to a Table, PivotTable or PivotChart.51



Queries & Connections

Queries & Connections ~ x | There are also some useful messages displayed in the Queries & Connections
Queries | Connections W|nd0W for eaCh quel’y.

4 queries

It will show you:

4 7 Customer [2]
F3 Customer_Data * if the query is a connection only query,
Connection only.

s e if there were any errors when the query last ran, or

! Download did not complete,

4 i Sales [2] * how many rows loaded if it is not a connection only query.
2 Sales_Data

Connection only.

0] Sales_Data_2 ¥
1,145 rows loaded.

Other Queries

j"‘“—k*”r.,’»—‘-“*’,"__



Power Query
how does it work?

Basic Approach:

* Looks at a preview of your data

Imports and Transforms the data
* Applies “Types” to your Data

* Loads the query to connection, data model or (in Excel) a table

To Refresh a Power Query:

* C(Click the Refresh button

* Power Query runs the updated source file through the same steps!
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Power Query
what shall we learn?

* Loading Data
* Splitting Data
* Reshaping Data
* Combining Data

* Appending Data
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Loading Data
Creating a Staging Query

Step Tasks to perform
1 Prepare the Source Data

* Connect to your Data source
* Perform any desired transformations
* Name your query

2 Load as Staging query

* Goto Home - Close & Load - Close & Load To...

* Choose: Only Create Connection

* Uncheck: Add this data to the Data Model

Note: Staging queries ...

Import Data ? X

Select how you want to view this data in your workbook.

O Table
() PivotTable Report
15 O PivotChart
[E* @ only Create Connection
Where do you want to put the data?
Existing worksheet:

I

=$BS5

New worksheet

DEAdd this data to the Data Model;

Properties.. Cancel

- do not consume any processor or RAM until they are called by another query.
- can be very helpful in order to act as a starting point for other queries.

welpLul
Tips



Loading Data
Modifying Query Load Destinations

Step

1

Note:

Tasks to perform
Display the Queries & Connections Pane

* Excel 2010/2013
* Excel 2016
* Excel 2019/365

Power Query ->Show Pane
Data =>Show Queries
Data ->Queries & Connections

Modify the Load Destination

* Right click the desired query -Load To...
* Modify the load behavior as desired

Import Data ? X

Select how you want to view this data in your workbook.

O Table
() PivotTable Report
15 O PivotChart
[E* @ only Create Connection
Where do you want to put the data?
Existing worksheet:

I

=5BS5

MNew worksheet

,:]EAdd this data to the Data Model;

Cancel

Properties..

If you accidentally loaded a query to a table, you can convert it
to a Connection Only query by simply deleting the worksheet.

pelpLul
Tips
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Splitting Data

Splitting Records into Columns

Step
1

2
3
4

Note:

Result

Tasks to perform

Right click the Values column

Choose to Split Column - by Delimiter
Choose appropriate Delimiter

Click OK

This works best where:
* Desired Output is Pivoted
* Number of elements will never change

It is a good idea to remove the auto-generated Changed Type step
in case the number of columns changes on update.

Bl ? Days - |12y Mondsy = |12y Tuesday ~ |12y Wernesdsy ~ |12y Thersdey
1 |20L8-01-0& £2:00:0 2
Z01B8-01-1%

I1Z:=00:0

d0IE-01 -0 1230030

= 12y Friday

-

N

= #dy Seturdsy

welpLul
Tips

Source

weekendRlivaiue: |
Devys

Mondoy
Tuasday
Wodnasday
Thursdlay
Frley
Saturday
Sunday

" 2013-m1-051

- |1¥y Sunday -

L3

2

%
5
6
7
I
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Splitting Data

Splitting Records into Rows

Step
1

2
3
4

Note:

Tasks to perform

Right click the Values column

Choose to Split Column - by Delimiter
Choose appropriate Delimiter

Click Advanced ->Split to Rows 0K

This works best where:
* Desired Output is Unpivoted
* Number of elements may change

Source

Date [l Aecords [
A0LE-01-51 Dog

Cat

Mowse
A0LF-02-26 Gerbil

Horm=
A13-03-31 Dog

Cat

Mose

Hars=

relpLul

Tips

':- Fecorch

£ Hexaa
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Reshaping Data

Pivoting Data

Step Tasks to perform
1 Select the [Pivot] column
2 Go to Transform —Pivot Column
3 Select from the Values 'drop-down' column
4

Click OK

Pivot Column m

Use the names in column “Category” to create new columns.

Values Column @

Sales

P Advanced options
Learn more about Pivot Column

OK

Result

Source

Date B Category

2018-01-31 Howler
204B-01-31 Blue
2018-01-31 Panas
2018-02-23 Golden
2018-032-23 Patas
201B-03- 31 Hoewler
2018-03-31 Blye
2018-03-31 Golde=n
201B-03-31 Patas

Date a Howler ’ Blue = Patas

2015-01-31
2018-02-28
2015-03-31

3

4

3

BisalesEl

M H Ak H KB W

ﬂ Golden '!

)
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Reshaping Data

Transposing Data

Step
1

Note:

Tasks to perform

Prepare the Source table
- Filter out Total and Subtotal rows
- Delete any Total and Subtotal columns

Transpose the Data

- Demote headers if you wish to keep them
- Go to Transform - Transpose

- Promote First Row to Headers

- Set data types

To Demote Headers, go to ...

Beer

Wins

1m
138
103

pelpLul
Tips

Home > Use Headers as First Row [ Use First Row as Headersig

To Promote to Headers, go to ...

™ Use First Row as Heade

Home —>Use First Row as Headers  [X]  Use Headers as First Row

)nsay
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Combining Data
7 ways to Join your Data

.

Full Anti Join

All Unmatched
from both

Full Outer Join

Inner Join

<)

All Matched Everything

e from both from both
‘ \“?QY\}}S};\ (no red, no yellow) Left & Right (red + yellow)
Left Outer Join : —3 Right Outer Join
Transactions Chart of Accounts 5 9
. i :
Everything accounid pept Bpate B amount K3 account B3 vept Bl name v| { Eve rythmg
from Left 64010 150 2015-12-15 8,975 64010 150 Revenue- 18Holes 3 from Right
(no ye||0w) 64020 150 2015-12-15 13,708 64020 150 Revenue - 9 Holas ; (no red)
64030 150 2015-12-15 32,555 64030 150 Revenue- Twilight ¢
64010 250 2015-12-15 22,752 64040 150 Revenue - Special .2
. . 64010 250 Rentals - Power Cart y . . .
Left Anti Join 250 2015-12-15 19,733 64020 250 Rentals- Pull Cart 3 Right Anti Join
) 250 2015-12-15 33,133 64030 250 Rentals - Clubs :
All Unmatched 64010 350 2015-12-15 45,876 64040 250 Revenue - Golf Balls

from Left

«©

(only red)

ST T T T T T i VTN g

S

NS

All Unmatched
from Right @
(only yellow)
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Combining Data
7 ways to Join your Data

1.

2

89885

Inner Join

Full Outer Join
Left Outer Join
Right Outer Join
Left Anti Join
Right Anti Join

Full Anti Join

Which of the T joing
doec each percon T"&\'

fall under &
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Combining Data

Inner Join
Step Tasks to perform
1 For each table
- Create a staging query (load as Connection Only)
2 Merge the Data
- Reference the Source table
- Go to Home - Merge - Lookup table
- Select the [Key] column(s) on both tables
3 Expand the Data
- Expand the new column
- Uncheck the [Key] column(s)
- Consider unchecking Preface option
Note: Use multiple columns for your [Key] column by

holding down the CTRL key while selecting them.

Source Table

Account - Dept ﬂ Amount R4
150

64010

8,975 |

64020

150 13,708 |

64030

150 32,555 |

pelpLul

Tps |

Pink records have no match in

Lookup so are excluded from result

Account n Dept n Amount H Name >

64010 150 8,975 Revenue - 18 Holes
64020 150 13,708 Revenue - 9 Holes
64030 150 32,555 Revenue - Twilight
64010 250 22,752 Rentals - Power Cart
64030 250 15,733 Rentals - Clubs
64040 250 33,433 Revenue - Golf Balls

150 Revenue - 18 Holes

64020 150 Revenue - 9 Holes
64030 150 Revenue - Twilight
64040 150 Revenue - Special
64010 250 Rentals - Power Cart
64020 250 Rentals - Pull Cart |
654030 250 Rentals - Clubs

64040 250 Revenue- Golf Balls |

Lookup Table ]

.
Yellow records have no

match in Source so are
excluded from result
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Combining Data

Full Quter Join

Step
1

Note:

Tasks to perform

For each table

- Create a staging query (load as Connection Only)

Merge the Data

- Reference the Source table

- Go to Home - Merge - Lookup table

- Select the [Key] column(s) on both tables
- Use a Full Outer Join

Expand the Data

- Expand the new column

- Uncheck the [Key] column(s)

- Consider unchecking Preface option

Use multiple columns for your [Key] column by

holding down the CTRL key while selecting them.

Source Table

64010 150 8,975

BA020 150 13,708 |
64030 150 32,555 |
£4010 22 |
64020 250 19,723 |

Key
Columns

150 Revenue - 18 Holes
64020 150 Revenue - 9 Holes
64030 150 Revenue - Twilight
64040 150 Ravenue - Special
64010 250 Rentals - Power Cart
64020 250 Rentals - Pull Cart
64030 250 Rentals - Clubs

64040 250 Revenue - Golf Balls J

~—

Lookup Table

—

pelpLul
Tips
Pink records Yellow records
a0 A M| are included in
result result )
account @ pept B Amount B wName v
64010 150 8,975 Revenue - 18 Holes
64020 150 13,708 Revenue - IHoles
64030 150 32,555 Revenue - Twilight
64010 250 22,752 Rentals - Power Cart
) : _ Revenue - Spacial
64030 250 19,733 Rentals- Clubs |
Rentals - Pull Cart
2 L 33W
64015 150 24,147

276

[Account] & [Dept]

shown here are from
the Source table only
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Combining Data
Left Outer Join

Step
1

Note:

Tasks to perform

For each table
- Create a staging query (load as Connection Only)

Merge the Data

- Reference the Source table

- Go to Home - Merge - Lookup table

- Select the [Key] column(s) on both tables
- Use a Left Outer Join

Expand the Data

- Expand the new column

- Uncheck the [Key] column(s)

- Consider unchecking Preface option

Use multiple columns for your [Key] column by
holding down the CTRL key while selecting them.

Source Table

64010 150 8,975
64020 150 13,708
64030 150 32,555
ga010 220 2275

64015 150 34,187
64030 250 19,733
64040 250 33,438
64010 350 45,375

Key
Columns

3 R
-

Columns

Account [§d pept B Nname v |

64010

150 Revenue - 18 Holes

64020

150 Revenue - 9 Holes

64030 150 Revenue - Twilight
e4040 150 Revenue - Special
64010 250 Rentals - Power Cart
64020 250 Rentals - Pull Cart
64030 250 Rentals - Clubs

64040 250 Revenue - Golf Balls |

G

Lookup Table

Account @ pept B amount B name v

64010

pelpLul

Tps

Pink records have no

match in Lookup so are
included in result

150

8,975

Revenue - 18 Holes

64020 150 13,708 Revenue-S5Holes
64030 150 32,555 Revenue - Twilight
64010 250 22,752 Rentals - Power Cart
64030 250 19,733 Rentals- Clubs |
02020 220 233438 Aevenus - GollBalle,
64015 150 34,147
64010 350 45876

\
Yellow records have no
match in Source so are
excluded from result

4
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Combining Data
Right Outer Join

Step
1

Note:

Tasks to perform

For each table
- Create a staging query (load as Connection Only)

Merge the Data

- Reference the Source table

- Go to Home - Merge - Lookup table

- Select the [Key] column(s) on both tables
- Use a Right Outer Join

Expand the Data

- Expand the new column

- Uncheck the [Key] column(s)

- Consider unchecking Preface option

Use multiple columns for your [Key] column by
holding down the CTRL key while selecting them.

Source Table

10 13,7
150 32,555

64010

pelpLul

Tps

Pink records have no

match in Lookup so are
excluded from result

account [ vept B amount B name - |

150 8,975 Revenue - 18 Holes

64020
64030

Key I ;
Columns 64010

64030

Key
Columns #1040

account @ nept §d Name v
64010 150 Revenue - 18 Holes
64020 150 Revenue - 9 Holes
64030 150 Revenue - Twilight
84040 150 Revenue - Special
64010 250 Rentals - Power cart
64020 250 Rentals - Pull Cart
64030 250 Rentals - Clubs
64040 250 Revenue - Golf Balls

J
Lookup Table ]

P

150 32,555 Revenue - Twilight |

250 22,752 Rentals - Power Cart
Revenue - Special

250 19,733 Rentals- Clubs |
Rentals - Pull Cart

250 32,438 Revenue- GolfBalls |

150 13,708 Revenue -9 Holes ]
|
|

Yellow records have no
match in Source so are
included in result
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Combining Data
Left Anti Join

Step
1

Note:

Tasks to perform

For each table
- Create a staging query (load as Connection Only)

Merge the Data

- Reference the Source table

- Go to Home - Merge - Lookup table

- Select the [Key] column(s) on both tables
- Use a Left Anti Join

Expand the Data

- Remove the [Key] column(s)

- Expand the new column

- Consider unchecking Preface option

Use multiple columns for your [Key] column by
holding down the CTRL key while selecting them.

-
pelpLul
Tips

Source Table

64010 150 8,975
64020 150 13,708
giﬁ e Pink records have no match in
Lookup so are included in result
64030 250 15,733
2
376 64015 150 34,147

64010 350 45,
Columns
All records that match

64010 350 45

between the two tables
are excluded from result

Yellow records have no
match in Source and are
excluded from result

150 Revenue - 18 Holes
150 Revenue - 9 Holes

64030 150 Revenue - Twilight |
64040 150 Revenue - Special
64010 250 Rentals - Power Cart
64020 250 Rentals - Pull Cart
64030 250 Rentals - Clubs

64040 250 Revenue - Golf Balls _J

[ Lookup Table ]
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Combining Data

pelpLul
Tips

Right Anti Join

Step
1

Note:

Tasks to perform Source Table

For each table “‘“’“ e
- Create a staging query (load as Connection Only) | 64020 150 13,708
ﬁ S—— Yellow records have no match in
Merge the Data - Source so are included in result
- Reference the Source table swsol 20l 15.7 PP pyr—— e p— =
- Go to Home - Merge - Lookup table 64040 150 Revenue-Special
64020 250 Rentals-PullCart
- Select the [Key] column(s) on both tables
- Use a Right Anti Join All records that match
' between the two tables
Expand the Data are excluded from result
- Remove the [Key] column(s) C°"g‘"5 — =
'
- Expand the new column 64010 150 Revenue- 18 Holes P'"It( Le.co[ds Eave nz
. . . | 64020 150 Revenue - 9 Holes MG s L
- Consider unchecking Preface option S TS T TG are excluded from result

64040 150 Revenue - Special
64010 250 Rentals - Power Cart

64020 250 Rentals - Pull Cart

Use multiple columns for your [Key] column by L 64030 250 Rentals- Clubs

h Id d h k h'l I . h 64040 250 Revenue - Golf Balls |
olding down the CTRL key while selecting them. Lookup Table ]

=
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Combining Data
Full Anti Join

Step Tasks to perform

d

N o o A WN

Note:

Source Table

Account - Amount ﬂ

Create Left Anti Join query | 64010 40482
, 64020 15,859

Create Right Anti Join query | 64030 38,003

64010 34,737 |

L__6a01s 33118 ]

Expand all fields from joined [Key] column(s) s 35

| 64040 20,257
64010 46,007,

Key
Column

Go to Home ->Append —>Right Anti-Join query '
Key

Column

Load as staging queries (Connection Only)

Reference Left Anti-Join query

Load to your destination

Account ﬂ Name
64010 Revenue - 18 Holes
64020 Revenue - 9 Holes
64025 Revenue - Senior 9
64030 Revenue - Twilight
64040 Revenue - Special

Ensure names of columns are identical in both the
Left Anti Join & Right Anti Join queries.

[ Lookup Table

Only items where the Key column

doesn’t have a match will be
displayed

Account B amount B coa.account B coa name

=210

pelpLul
Tips

This join is not available
in the user interface and

must be created
manually!

64025 Revenue - Senior 9 |



Combining Data
Exact Match

Step
1

Tasks to perform

Prepare Source table
- Set data types
- Load as Connection Only

Prepare lookup table

- Set data types

- Right click [Key] column ->Remove Duplicates
- Load as Connection Only

Perform the match

- Reference the Source table

- Go to Home ->Merge - Lookup table

- Select the [Key] column on both tables

- Use a Left Outer Join

- Expand the new column

- Uncheck the [Key] column and prefix option

pelpLul
Tips
[ ‘Source Table ]
= Date :7?123 ProductID ~ 123 Units:;]
' 2014-03-11 510007 54
2 2014-03-12 5
3 | 2014-03-12Z
| 4 | 2014-03-13 510007
5 2014-03-13 51 1¢
6 J014-03-13 £10038
_|Key|
Column|
' pate  |d Product D B units M
2014-03-11 3510007 04 29.50
Key | 2014-03-12 510014 62 11.50
Column 2014-03-12. 510007 45 29.50
e 2014-03-13 510038 30 14.50
E® 510007 29 2014-03-13 510014 76 11.50
=8 2014-03-13 510007 30 29.50

0
4
9

—
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Appending Data

Basic Append
Step Tasks to perform

1 Create a “Stagingl” query
- Create a query that connects to Data Source 1
- Make the required transformations
- Load as Connection Only

2 Create a “Staging2” query
- Create a query that connects to Data Source 2
- Make the required transformations
- Load as Connection Only

3 Append the Data

- Right click the “Stagingl” query

- Choose Reference

- Go to Home RlAppend

- Select the “Staging2” query

- Perform any additional required transformations
- Load to your destination of choice

e
tagin

£t

“@E«(((OI

telpLul

1 gl
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